SAP MaxDB Database Studio: Database Analyzer Charts
# Content

<table>
<thead>
<tr>
<th>1</th>
<th>Introduction to Database Analyzer Charts</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>A Quick Tour (Synopsis)</td>
<td>5</td>
</tr>
<tr>
<td>2.1</td>
<td>Analyzing the performance while being connected to the database</td>
<td>5</td>
</tr>
<tr>
<td>2.2</td>
<td>Analyzing the performance offline</td>
<td>5</td>
</tr>
<tr>
<td>3</td>
<td>Using Database Analyzer Charts</td>
<td>7</td>
</tr>
<tr>
<td>3.1</td>
<td>Starting Database Analyzer Charts</td>
<td>7</td>
</tr>
<tr>
<td>3.2</td>
<td>The Database Analyzer User Interface - an Overview</td>
<td>8</td>
</tr>
<tr>
<td>3.3</td>
<td>Working with Database Analyzer Charts</td>
<td>9</td>
</tr>
<tr>
<td>3.3.1</td>
<td>Prerequisites</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Opening Database Analyzer Files for Charting</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>Table and Column List in Detail</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>Functionality of the Table and Column List</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td>Virtual Columns</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>The (Diagnosis) Chart View in Detail</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>Functionality of the Diagnosis Chart View/How To...</td>
<td>18</td>
</tr>
<tr>
<td></td>
<td>Combining two CSV Files to a merged Product</td>
<td>21</td>
</tr>
<tr>
<td>3.4</td>
<td>Metric Templates</td>
<td>21</td>
</tr>
<tr>
<td>3.4.1</td>
<td>Working with Metric Templates</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>Specifying the Location for Remote Metric Templates</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>Overriding the Default Metric Template of a CSV File</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>Defining Named Metric Templates</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>Using Named Metric Templates</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>Comparing two Views of a different Metric at the same Time Interval</td>
<td>24</td>
</tr>
<tr>
<td></td>
<td>Defining a Default Time Interval</td>
<td>24</td>
</tr>
<tr>
<td>4</td>
<td>Setting Up a Database Analyzer Project</td>
<td>25</td>
</tr>
<tr>
<td>4.1</td>
<td>What is a Database Analyzer Project?</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>In Detail</td>
<td>25</td>
</tr>
<tr>
<td>4.2</td>
<td>Multiple Opportunities and Ways for Analyzing Database Analyzer Data</td>
<td>26</td>
</tr>
<tr>
<td>4.3</td>
<td>Performing an Analysis</td>
<td>26</td>
</tr>
<tr>
<td>4.4</td>
<td>Retaining an Analysis</td>
<td>27</td>
</tr>
<tr>
<td>4.5</td>
<td>Reproducing an Analysis</td>
<td>28</td>
</tr>
<tr>
<td>4.6</td>
<td>Applying a predefined Analysis to another database</td>
<td>28</td>
</tr>
<tr>
<td>4.7</td>
<td>Performing the same analysis for another point in time</td>
<td>28</td>
</tr>
<tr>
<td>4.8</td>
<td>Comparing results comfortably</td>
<td>28</td>
</tr>
</tbody>
</table>
5 Working Offline with Database Analyzer Data ........................................ 30
  5.1 Settings for Working offline with Database Analyzer Data ................ 30
      Defining Local Locations for remote Database Analyzer Data .......... 30
      Associating the Diagnosis Editor with Database Analyzer Files. ........ 31
      Importing Database Analyzer Data into the Local Locations .......... 31
  5.2 Working Offline with the Database Analyzer Data in the Explorer View. 31
  5.3 Working with the Navigator ........................................................ 32
      Working offline with the Navigator ........................................... 32
      Defining a Linked Folder in the Navigator View ........................... 32
1 Introduction to Database Analyzer Charts

The Database Analyzer is SAP MaxDB’s main tool for examining the state and performance of database instances. The Database Analyzer writes multiple log files in preset intervals. Based on this data which is stored as csv formatted files, the analyzer builds reports on the state of the database.

So far the database administrator had no influence on the MaxDB Analyzer reports.

This changes completely with Database Analyzer Charts: The Database Analyzer Charts together with the predefined Metric Templates provide a new functionality, which enables the administrator for the first time to visualize the collected performance data of the database. Now it is possible to create arbitrary reports and graphical evaluations based on any combination of data in the logging files.

Database Analyzer Charts enables you to:

- analyze database data graphically.
- choose freely which metrics shall be displayed in the graph.
- define a time span for the graph.
- navigate between recently opened charts and time spans.
- benefit from predefined anlyses that open automatically with many Database Analyzer files.
- adjust predefined anlyses by changing the settings according to your needs.
- apply an analysis that you have done for a table upon another table (even from another database).
- save your analysis as a template so that you can reuse it.
- share your templates with colleagues.
- combine data from multiple tables in one graph.
- hide and display individual columns in the table.
- rearrange the column order within the table.
- add virtual metrics with derived values.
- define threshold values that issue visual warnings if they are surpassed or undershot.

This documentation is divided into four parts:

- Introduction to Database Analyzer Charts [page 4]
- Using Database Analyzer Charts [page 7]
- Setting Up a Database Analyzer Project [page 25]
- Working with the Navigator [page 32]
2  A Quick Tour (Synopsis)

In this chapter two main use cases are sketched.

1. Analyzing the performance while being connected to the database [page 5]
2. Analyzing the performance offline [page 5] (based on Database Analyzer data downloaded before)

2.1 Analyzing the performance while being connected to the database

- Start Database Studio
- Connect to a database instance
- Make sure there exists Database Analyzer data regarding the time interval you want to analyze. Maybe it is being collected right now (i.e. the Database Analyzer is running). See Starting Database Analyzer Charts [page 7] for details.
- Navigate to the MaxDB Analyzer log files directory
  - On folder Diagnosis Files choose the right mouse function Extended File List to make the subdirectory Database Analyzer File visible.
  - The subdirectory Database Analyzer File contains all Analyzer files (csv-format, one directory for each day)
- Choose one or more log files for analyzing
- Select a csv file for display (double click)
- The contents of the file appear in the display area for log files, and a list of all columns appears to the right of the display area
- Select columns for charting (from the column list)
- Choose a time span for charting
- Compare data with widespread value ranges (second ordinate with different scale)
- Check data (same time span) against data from other csv-files
- Export charts to image files
- Open, Edit and Save Metrics

2.2 Analyzing the performance offline

Prerequisites

Database Analyzer Data has been already collected and downloaded from the respective database's server.

Step by Step
- Start Database Studio
- Set the “Repository” Preferences if not yet done (see Defining Local Locations for remote Database Analyzer Data [page 30] for details). Restart Database Studio after defining the Repository links.
  Set the Metric Folder Preferences if you want to work with previously defined or other Metric Templates stored in a remote folder (see Specifying the Location for Remote Metric Templates [page 22] for details).
  Set the associated editor if not yet done (see Settings for Working offline with Database Analyzer Data [page 30] for details).
- Navigate to the repository folder Diagnosis Local Folder or Diagnosis Shared Folder respectively
- Navigate to the Database Analyzer log files directory of interest. Either to a date folder or to the respective CSV file.
  - Choose one or more date folders and open the chart in one of several ways
    - Double click a CSV file or
    - Via context menu function choose Display via Metric Template and choose an adequate metric template.
  - If you have chosen two or more date folders
    - Via context menu function choose Merge via Metric Template and choose an adequate metric template
- In the chart window you can
  - Select additional columns for being displayed as graph
  - Choose a time span (Use the right scale)
  - Export charts to image files
  - Save the analysis as Metric Template
3 Using Database Analyzer Charts

Database Analyzer Charts enables the visualization of Database Analyzer data. In this chapter all functionality of Database Analyzer Charts is described. It will be shown how to work with the user interface in order to

- visualize the collected data
- merge different metrics with each other or
- compare the metrics with another point in time or with another system.

This chapter covers the following topics:

- Starting Database Analyzer Charts [page 7]
- The Database Analyzer User Interface - an Overview [page 8]
- Working with Database Analyzer Charts [page 9]
- Metric Templates [page 21]

3.1 Starting Database Analyzer Charts

To start and stop Database Analyzer you can use one of the following tools:

- CCMS (in SAP systems only) DBA Cockpit, Database Analyzer
- Database Studio, Starting or Stopping Database Analyzer
- Database Manager CLI, Analyzing Databases

When the Database Analyzer is active it collects performance relevant data from the database and writes it to log files at regular intervals. These log files are called Database Analyzer files. Based on these Database Analyzer files it is possible to spot performance bottlenecks and other problems and to improve the overall database performance and safeness.
3.2 The Database Analyzer User Interface - an Overview

This chapter describes the main components of the Database Analyzer Charts Window. Beside the standard elements of the Database Analyzer (like the menu bar and button toolbar) the graphical user interface is comprised of four parts:

1. **The Explorer View**

   The Explorer view provides the access to your database server and database instances. From here you can log in to a database instance and open the Database Analyzer files.

2. **The Table/Editor View**

   The Database Analyzer files you have opened are shown in this part of the window. The files are written in csv-format and are displayed as tables. You may open as many files as necessary for analysis.

3. **The Column List**

   The Column list catalogues all columns of the active Database Analyzer file. From here you can choose both
   - which columns are shown in the Table view and
   - which columns are the metrics to be shown in the Diagnosis chart.

4. **The Diagnosis Chart**

   This is the chart view. Every chosen column represents a metric which is displayed as graph here in this chart view, i.e. the columns that are selected in the Column list are automatically drawn as a line chart.
The x-axis is the timeline axis and the y-axis shows the value range of the metric. Both adapt themselves to the chosen time interval and the value range of the chosen metric.

In the following we will explain the usage of Database Analyzer Charts in detail and will explain the individual elements and options that are provided for analysis of database performance.

### 3.3 Working with Database Analyzer Charts

This chapter describes how the user interface functionality can be used to make the performance information visible, to better understand correlations between metrics and finally to store the findings in order to reproduce them.

#### 3.3.1 Prerequisites

After starting Database Studio make sure there exists Database Analyzer data regarding the time interval you want to analyze. Maybe it is being collected right now (i.e. the Database Analyzer is running).

Instead of analyzing Database Analyzer data of a database instance while accessing it via login you can also work on previously collected Database Analyzer data.

See [Working Offline with Database Analyzer Data](page 30) for details.

#### 3.3.2 Opening Database Analyzer Files for Charting

Navigate to the Database Analyzer Files in one of basically two ways:

- Opening Database Analyzer Files for Charting while being Online
- Opening Database Analyzer Files for Charting while being Offline

You can open the appropriate csv-files with a double-click:

#### 3.3.2.1 Opening Database Analyzer Files for Charting while being Online

- On the DBM-operator login right-click on the "Diagnosis files" folder and select the function "Extended file list" from the context menu.
- Open the Database Analyzer Folder and open on the next folder level one folder named like a date in the format yyyyymmdd. Here you see all your *.csv files with the Database Analyzer data.
• Double click the csv file of interest: f.e. DBAN_CPU_UTILIZATION.csv
• Double click the file: DBAN_CACHES.csv
• If you do this for the very first time and no chart view with respective metrics is displayed then there exists no default metric template for this Database Analyzer file
• Double click a column so that the Diagnose Chart View in the bottom part of the screen appears displaying the chosen metric as graph.
• Enlarge the "Diagnosis Chart" area if necessary.

3.3.2.2 Opening Database Analyzer Files for Charting while being Offline

The Database Analyzer log files are located in the subdirectories Diagnosis Files / DB Analyzer File / yyyymmdd of the Explorer view.

You can open the appropriate csv-files with a double-click:

• the files open as tables in the editor
• on the right side of the table a column list of the active table appears
• the path, name and creation date of the active file appear as headings in the Diagnosis Chart view
  It may happen that Database Studio doesn't show the Diagnosis Chart view. In that case you only need to select a metric, that means:
• double click on one of the column headings in the column list.

3.3.3 Table and Column List in Detail

This chapter covers the following topics:

• Elements/Components of the Table Editor and the Column List [page 10]
• The Column List [page 11]
• Identifying which Column in the Table Corresponds to the Column in the Legend [page 11]
• The Context Menu of the Table Editor [page 11]
• The Context Menu of the Column List [page 11]

3.3.3.1 Elements/Components of the Table Editor and the Column List

When a csv file is opened the editor will show all columns of the table. The column headings show abbreviated names.

It is possible to view the complete name by placing the mouse pointer over a column heading. The order of the columns can be rearranged by dragging the column heading to the left or right.
3.3.3.2 The Column List

The column list on the right side of the table shows the complete list of the columns of the selected Database Analyzer File. The column names here are the long and completely specified names.

Initially all columns are displayed in the table presentation and therefore their column names appear in bold type face.

3.3.3.3 Identifying which Column in the Table Corresponds to the Column in the Legend

The legend right next to the table and the legend on the left hand side of the chart view show the full names of the columns.

In the table the acronyms (short names) are used as column headings.

To identify the corresponding column in the table:

- Move the mouse pointer over the column headings of the table. The full column names will be displayed.

3.3.3.4 The Context Menu of the Table Editor

The Table Editor provides a context menu. For each table you can choose multiple commands:

- Merge with... [<opened_table>.csv] [Error message ? Q]
- Save as Metric Template [feature in development] ? Column list context menu
- Save as Default Metric Template

3.3.3.5 The Context Menu of the Column List

The column list provides a context menu. For each column you can choose multiple functions:

- **Hide in table** Choose this menu item to hide a column in the table editor view. In the column list the hidden column name will appear in normal type face.
- **Show in table** This reverses the above command. The previously hidden column is displayed again in the table. In the column list the column name will appear in bold type face.
- **Hide in diagram** A column that was previously shown in the Diagnosis Chart view will no longer been displayed in the Diagnosis Chart view.
- **Show in diagram** The selected column will be displayed in the Diagnosis Chart view. Its values for the selected time span are drawn as a line chart in the Diagnosis Chart view.
• **Set Minimum Value** You can set a minimum value for a column that should not be fallen short. If the value for an individual table cell falls below the specified minimum value a warning sign will appear in the respective table cell.

• **Set Maximum Value** You can set a maximum value for a column that should not be exceeded. If the value for an individual table cell exceeds the specified maximum value a warning sign will appear in the respective table cell.

• **Add new Column** You can add new columns to a table. These columns are derived from one or more existing columns. You can specify formulas to calculate the values of the new column.

• **Show/Hide invisible Columns** This command allows you to temporarily remove hidden columns (using Hide in table) from the column list. You regain (restore the visibility of) the columns by choosing the command again. This command allows you to show the previously hidden columns in the table. The set of the hidden columns is stored/saved. Therefore you can hide the complete set by choosing the command again.

• **Save as Metric Template** This option allows you to save the current set of ...

• **Save as Default Metric Template**

### 3.3.4 Functionality of the Table and Column List

This chapter covers the following topics:

- **Rearranging the Column Order** [page 12]
- **Sorting Tables** [page 12]
- **Selecting a Metric for Display in a Chart** [page 13]
- **Hiding and Displaying a Column in the Table** [page 13]
- **Issuing Warnings for Values** [page 13]
- **Removing Warnings for Values** [page 14]
- **Virtual Columns** [page 14]
- **Adding Virtual Columns with Derived Values** [page 14]
- **Editing the Script (Formula) of a Virtual Column** [page 15]

### 3.3.4.1 Rearranging the Column Order

To rearrange the column order of a table

- drag the column titles of the table to the desired position
- drag the column names in the column list to the desired position

### 3.3.4.2 Sorting Tables

To sort a table according to a specified column

- click on the appropriate column heading in the table editor
To toggle between ascending and descending sort order

- click repeatedly on the appropriate column heading in the table editor

### 3.3.4.3 Selecting a Metric for Display in a Chart

To make a Column visible in the Table and the Chart-View double click on a column in the legend:

- this will enable the column to be presented in the table and the chart

Right mouse click on a column in the legend to open the context menu:

- from the context menu you can choose to present the column in the table or in the chart

### 3.3.4.4 Hiding and Displaying a Column in the Table

If you want to restrict the width of the table, you can decide to hide those columns that do not interest you.

Right click on the column name and choose Hide in table or Show in table from the context menu

### 3.3.4.5 Issuing Warnings for Values

It is possible to specify individual maximum and/or minimum values for each column of a table (which should not be surpassed or undershot). Warnings are issued in case of exceeding or falling below (beneath) these limiting values.

To issue a warning for table cell values of a column that exceed a specific value:

- Right-click on the appropriate column name in the column list and choose Set Maximum Value from the context menu
- Enter a valid number in the dialog box
- Click ok

Any table cell with a value higher than the specified value will be marked with a warning sign.

To issue a warning for table cell values of a column that fall below a specific value:

- Right-click on the appropriate column name in the column list and choose Set Minimum Value from the context menu
- Enter a valid number in the dialog box
- Click ok

Any table cell with a value lower than the specified value will be marked with a warning sign.
3.3.4.6 Removing Warnings for Values

To remove warnings for table cells which exceed a specified value

- Right-click on the appropriate column name in the column list and choose Set Maximum Value from the context menu
- Enter NaN (acronym for Not a Number) in the dialog box
- Click ok

To remove warnings for table cells which fall below a specified value

- Right-click on the appropriate column name in the column list and choose Set Minimum Value from the context menu
- Enter NaN in the dialog box
- Click ok

3.3.5 Virtual Columns

Virtual columns are columns that can be added subsequently to the table. The values of the virtual column are calculated based on the formula specified. The formula can include the values of one or more columns of the respective table.

Virtual columns can be helpful in diagnosing database performance and analysis of weak points.

3.3.5.1 Adding Virtual Columns with Derived Values

- Right-Mouse click on a column name in the column list and choose Add new Column from the context menu.
- Choose Add new column from the context menu of the column list.
  
  A dialog box pops up and allows you to define a Name, an Acronym and a Script (formula) for the new column.
  
  **Note:** it is not necessary to use an equal sign (=) to start the formula.
  
  You can formulate any formula depending on the existing columns. As a typing aid just type CTRL-Space and all the column names that can be chosen appear in a list to be picked out.
  
- Click Finish to close the dialog box. The virtual column will be added to the table.

Now you can work with this virtual column as if it were an original one.
### 3.3.5.2 Editing the Script (Formula) of a Virtual Column

To edit the script (formula) of a virtual column:

- Right-Mouse click on a column name in the column list and choose Edit Column from the context menu.
- Edit the formula as required.
- Click Finish to close the dialog box and apply the changes

The values of the virtual columns are recalculated according to the new formula.

### 3.3.5.3 Arithmetic Operations, Functions and Constants in Scripts (Formulas)

For the creation and editing of formulas for virtual columns MaxDB Analyzer Charts supports all arithmetic operations that are provided by JavaScript. MaxDB Analyzer Charts also comprises the JavaScript Math object and therefore supports all math functions and math constants of this object.

This chapter covers the following topics:

- Arithmetic Operations [page 15]
- Mathematical Functions [page 16]
- Mathematical Constants [page 16]

#### 3.3.5.3.1 Arithmetic Operations

Unary Operators (for Operations with one Operand)
- reverse the sign
- bitwise not
++ auto-increment
-- auto-decrement

Binary Operators (for Operations with two Operands)
+ Addition
- Subtraction
* Multiplication
/ Division
% Modulos (remainder of division of two operands)
& bitwise AND | bitwise OR
^ bitwise XOR
Shift Operators (for Bit Operations)

<< bitwise left shift (filling in zeros from the right)
>> bitwise right shift
>>> bitwise right shift (filling in zeros from the left)

### 3.3.5.3.2 Mathematical Functions

- Math.abs(var) Absolute value of var
- Math.ceil(var) Smallest integer greater than var
- Math.exp(var) e to the power of var
- Math.floor(var) Largest integer smaller than var
- Math.log(var) Log of var base e
- Math.max(var1, var2) Maximum of var1 and var2
- Math.min(var1, var2) Minimum of var1 and var2
- Math.pow(var1, var2) Exponentiation (var1 to the power of var2)
- Math.random() Random number between 0 and 1
- Math.round(var) Integer that is closest to var
- Math.sqrt(var) Square root of var

### Trigonometric functions

- Math.acos(var) arc cosine of var
- Math.asin(var) arc sine of var
- Math.atan(var) arc tangent of var
- Math.atan2(var1, var2) arc tangent of var1/var2
- Math.cos(var) cosine of var
- Math.sin(var) sine of var
- Math.tan(var) tangent of var

### 3.3.5.3.3 Mathematical Constants

- Math.PI \( \pi, 3.141592\ldots \)
- Math.E \( E, 2.718281\ldots \)
- Math.LOG2E log of e base 2 (base-2 log of E)
- Math.LOG10E log of e base 10 (base-10 log of E)
Math.LN2 log of 2 base e (natural log of 2)
Math.LN10 log of 10 base e (natural log of 10)
Math.SQRT2 square root of 2
Math.SQRT1_2 square root of 1/2

3.3.6 The (Diagnosis) Chart View in Detail

3.3.6.1 Elements/Components of the Diagnosis Chart View

The Chart View is made up of these components (A: The Chart, B: Controls):
Depends on what this chart has been created from.
- Double click on CSV without Default Metric Template
- Double click on CSV with Default Metric Template
- Displayed via a named Metric Template built on one CSV-File
- Displayed via a named Metric Template built on more than one CSV-File
- Manual Merge over different dates
- Manual Merge over different database instances
- Manual Merge of different single metrics
Chart Heading Server Address : Database Name / Log File Name <space> Date
X-axis (time)
Y-axis (values)
Legend
Zoom/View Controls
Acronyms (Button)
Fit to View
Number of Entries Field
Zoom Slider
Zoom and Optimization Info (text)
Acronyms Button toggles between full and abbreviated names in the chart legend
### 3.3.6.2 The Context Menu

Right-Clicking on the Diagnosis Chart View opens a context menu with the following items:

- **Save Image**: Allows you to save the current chart as an image in various graphic formats. Both pixel and vector based graphic formats are supported.
- **Back**: Restores the last chart view.
- **Forward**: Moves forward to the chart view that you left when you chose the Back option.
- **Select timespan in <opened_logfile>.csv**: Selects the currently chosen time interval in the specified table and switches to that table. All currently opened tables are offered as list to be picked out from.

### 3.3.7 Functionality of the Diagnosis Chart View/How To...

#### 3.3.7.1 Identifying which Metrics are displayed in the Chart

There are two ways to spot which metrics are currently displayed in the chart:

1. In the column list, a small colored polygon shows that this column is displayed as metric.
2. The diagram legend lists all displayed metrics.

#### 3.3.7.2 Selecting the Time Interval for the Displayed Data

There are multiple ways for selecting a time interval for the data displayed in the chart:

- Select a time interval by selecting the rows in the table presentation.
- Select the time interval by moving the left and right slide of the time interval on the time bar.
- Press the CTRL key and move the mouse wheel in one or the other direction to move the right slide.
- Select two points in the graph (double click on the left one, shift double click on the right one).
- Double click on the time bar to move the center of the time interval to the point just clicked.
- Define a preset time interval with the context menu command *Edit timespan*. In the dialog box set the selected time span as *default timespan* and the timespan will be applied to every newly opened metric.
3.3.7.3  Restoring the Chart Display of a Former Time Interval

To restore the chart display of a former time interval:

- Right mouse click on the chart view and select Back from the context menu
  This command can be used repeatedly if multiple time intervals have been selected before.

Once you have used the command it is possible to return to the current time interval.

To return to the current time interval:

- Right mouse click on the chart view and select Forward from the context menu

3.3.7.4  Displaying a Value on the Chart and Synchronizing it with the Table Content

To display the actual value of a data point on the chart:

- Move the mouse pointer to a point with a cross. The value of this point will be displayed.

To synchronize the table section with this part of the chart:

- Click the point on the chart. The table section will show the corresponding row at the top of the window.

3.3.7.5  Displaying a Second Scale on the Right Side

To display a certain column with its own scale:

- Click the column name in the column and choose the function Show in diagram (right scale) from the context menu. A second scale on the right side of the chart will be displayed (if it does not yet exist). The value range of the scale is adjusted according to the values of the selected column.

To make this right scale disappear:

- Choose the context menu Show in diagram or Hide in diagram if you do not want the right scale to be applied to this metric any more.

If you want to display certain graphs with the scale on the right side:

- Choose the respective columns with CTRL-click one after the other and choose the context menu Show in diagram (right scale) to display all chosen metrics on the right scale.

If you want to display all graphs with the scale only on the right side:

- Choose all columns with click and shift/click and then choose the context menu function Show in diagram (right scale).
3.3.7.6 Navigating between recently opened charts/time intervals

To restore previously created views:

- Right-Click on the diagnosis chart view and choose Back or Forward from the context menu.

3.3.7.7 Zooming in and out

It is possible to enlarge or reduce the scale in the horizontal and vertical direction.

To adjust the vertical direction:

- Use the zoom slider to enlarge or reduce the graph in the vertical direction.

To adjust the horizontal direction:

- Enter a number into Optimized for n Entries-box above the zoom slider and press Tab. This will stretch the graph accordingly.

3.3.7.8 Comparing different Charts for the same Time Interval

To compare the time span of the currently displayed chart with data from another table:

- Right click on the chart to open the context menu of the diagnosis chart view.
  The context menu adds an entry for every table that is opened in the table view.
- Choose the command Select timespan in nn.csv from the list list of opened files (where nn stands for the actual file name).
  The command applies the time span of the current chart to the selected file and displays its chart.

3.3.7.9 Exporting Image Files

It is possible to export the displayed chart in different image formats.

- Right-click on the diagram and choose Save Image from the context menu. In the dialog that opens:
  - Enter a name for the image file
  - Choose a location where the image shall be saved
  - Choose an image format for the file. There are five formats offered for your convenience

Once saved in a file you can print it out.
Database Analyzer Charts supports the following image formats:

- **BMP** (Bitmap image file): uncompressed raster graphics image file format
- **JPG** (JPEG, Joint Photographic Experts Group): raster graphics image file format with lossy compression
- **PNG** (Portable Network Graphics): raster graphics image file format that supports lossless data compression
- **PDF** (Portable Document Format)
- **SVG** (Scalable Vector Graphics): unlike the first three formats SVG is not a bitmap but a vector image format. Therefore graphics can be scaled by any amount without a loss in image quality. Text and vectors can easily be edited.

### 3.3.8 Combining two CSV Files to a merged Product

- Open two or more CSV Files of interest by double clicking them.
- Right mouse click on the header of a column in the table representation of the first CSV file.
- All other CSV files, that are visible are listed as candidate to be combined with the actual CSV file. Choose the one of interest via the context menu *Merge with ...*.
- As a result the table is enlarged by the second CSV file and the legend on the right side as well. The column names in the table as well as in the legend now have a prefix. This prefix identifies to which of the CSV file they belong.
- Choose whether you want the graphs to be merged from another start point in time.
- You can also correct the title of the resulting table and chart.
- Choose the interesting columns to be displayed in the chart.

**Hint:** It is easier to compare two graphs if you assign one graph to the left scale and the other to the right scale. This will keep the typical shape of the graphs recognizable.

The result of a combination of CSV files can now be used as if it were a single CSV file. This means that you can

- Add virtual columns
- Select a time interval for charting
- Adjust the displayed columns to the left or right scale
  
  You can store this merge as a named Metric Template. Use the context menu in the table view or on the column list.

### 3.4 Metric Templates

A metric template is a configuration file specifying which of the metrics shall be displayed by Database Studio. When certain Database Analyzer data of a specific database is opened, a corresponding metric template will be applied on these data. Thus, metric templates constitute something like predefined views on Database Analyzer data which help you examine the database state and behaviour.

There are basically two different kinds of metric templates. Database Studio comes with a set of predefined named Metric Templates as well as a set of Default Metric Templates. A Default Metric Template is activated when double clicking the a CSV file with the same name. A freely defined named Metric Template is a predefined
expert view on some general or specific metrics of database instances. In general it combines metrics of one or more CSV files.

Technically Metric Templates are configuration files in which it is specified which columns from a CSV file on which scale in which color shall be displayed as metric. Named Metric Templates bring several metrics of different CSV files in relation to each other and therefore allow a specific view on the database instance.

Metric Templates reflect actual expert knowledge and can be applied directly to the data from Database Analyzer. In addition they can be further enhanced according to the actual needs. You can create a reproducible analysis by storing the Metric Templates that were meaningful for you in a certain Database Analyzer Project.

3.4.1 Working with Metric Templates

Once you have worked with the charts and found the right way to present the data of interest it is useful to store all these properties as a metric template.

Database Studio comes with a couple of predefined metric templates. They are delivered together with the Database Studio software. Double clicking a CSV file always opens the default metric template belonging to this CSV file. There can not be more than one default metric template per CSV file.

Once you change the properties of the chart presentation you can override the settings of the default metric template.

If you want to come back to the default metric template of a CSV file, just restore the default metric template.

To restore the default metric template:

- In the Windows Explorer navigate to the folder where your personal default metric templates are stored in your Database Studio workspace. (e.g. C:\Users\<username>\sdb\DatabaseStudio\Database Diagnosis\Default Metric Templates)
- Delete the respective default metric templates if you want to come back to the default metric templates delivered with your software.

You can also see all your personal default metric templates out of Database Studio if you open the navigator view.

3.4.2 Specifying the Location for Remote Metric Templates

By default, self developed metric templates are stored in the workspace. In an Windows environment these are standardly the paths C:\Users\<user id>\sdb\DatabaseStudio\Database Diagnosis\Default Metric Templates and C:\Users\<user id>\sdb\DatabaseStudio\Local Metric Templates

Database Studio allows to define a distinct folder on your server or network where Database Studio expects to store and retrieve metric templates. This folder is meant for being shared with others.

It is recommended to store special predefined metric templates in this folder. e.g. metric templates delivered by SAP.
To set the path of the location, where custom and predefined metric templates are to be stored:

- Open Window → Preferences → Database Studio → Metric Folder.
- Here you can specify the location for your custom metric templates.

### 3.4.3 Overriding the Default Metric Template of a CSV File

- Right mouse click on any column header in the table view to open the context menu
  or
- Right mouse click in the column list on the right side of the table.
- Choose Save as Default Metric Template from the context menu. This stores the current display properties as the new default.

The new default properties will be active the next time you open a CSV file of this type in any date folder of Database Analyzer data.

### 3.4.4 Defining Named Metric Templates

- Right mouse click on any column header in the table view
  or
- Right mouse click in the column list on the right side of the table.
- Choose Save as Metric Template from the context menu.

You can store the display properties under a self defined name.

### 3.4.5 Using Named Metric Templates

- Open a Database Analyzer folder either under a specific database, under the explorer’s upper part or in the navigator view.
- Right click on the date folder of interest and choose Display via Metric Template from the context menu.

All metric templates in the metric template locations are listed.

Whereas the folder Local Metric Templates is predefined to be used without having set the preferences and the folder Metrics represents the folder set in the preferences (Preferences → Database Studio → Metric Folder).
3.4.6 Comparing two Views of a different Metric at the same Time Interval

To display the current time interval for a different data file:

- Right mouse click on the chart choose Select time span in ...csv. The context menu lists the currently opened data files. Choose the file on which to apply the time span which is currently displayed on the chart view.

3.4.7 Defining a Default Time Interval

It is possible to define a default time interval:

- Right click in the chart window choose the command/function "Set timespan" from the context menu.
- In the dialog box that opens you can define the Begin and End of the timespan you are interested in.
- Click the check box "set as default timespan" if you wish that every metric that will be opened from now on should be restricted to this default time span.

To remove the defined timespan:

- Click the button "clear timespan" if you wish to go back to the non-restricted timespan.
- To clear the default timespan setting you can also choose in the chart window the context menu Remove default timespan.
4 Setting Up a Database Analyzer Project

If you analyze the performance of a database you might repeat the analysis and look at the metrics of the database regarding another point in time or you might compare the metrics with another database.

In this section you learn how to save the metrics you found meaningful in your analysis so that you can use it either to reproduce the analysis, to compare the analysis with another point in time on the same database or even another database.

This chapter covers the following topics:

- What is a Database Analyzer Project? [page 25]
- Multiple Opportunities and Ways for Analyzing Database Analyzer Data [page 26]
- Performing an Analysis [page 26]
- Retaining an Analysis [page 27]
- Reproducing an Analysis [page 28]
- Applying a predefined Analysis to another database [page 28]
- Performing the same analysis for another point in time [page 28]
- Comparing results comfortably [page 28]

4.1 What is a Database Analyzer Project?

A Database Analyzer Project is a set of metric templates stored in a folder.

In order to repeat an analysis just apply the folder of metric templates onto the database/date folder of interest (context menu "Display via metric template").

In order to compare two points in time or two databases with each other just apply the project onto the two date folders (context menu "Merge via Metric Template").

4.1.1 In Detail

You can create a reproducible analysis by storing the Metric Templates that were meaningful for you in a certain Database Analyzer Project.

The MaxDB Database Studio distribution provides a set of "Metric Templates".

A metric template is a configuration file specifying which of the metrics shall be displayed by Database Studio. When certain Database Analyzer data of a specific database is opened, a corresponding metric template will be applied on these data. Thus, metric templates constitute something like predefined views on Database Analyzer data which help you examine the database state and behaviour.
Metric Templates reflect actual expert knowledge and can be applied directly to the data from Database Analyzer. In addition they can be further enhanced according to the actual needs.

Once you become yourself an expert you might want to build your own Metric Templates that show which of the collected Database Analyzer data reflected a certain situation you analyzed.

4.2 Multiple Opportunities and Ways for Analyzing Database Analyzer Data

Double click a CSV-file to see the effect of the default metric template which is part of the Database Studio delivery. Not every CSV-file has a default metric template. But if there is an assigned default metric, double clicking on a CSV file will show the metrics which were defined in the default metric template.

You might want to change the properties of the metric template and save it as your own default metric template.

You can adjust the following properties:

- Colors - Specify another color for displaying the metric
- Choose further metrics to be displayed in the chart view
- De-select metrics, which are selected per default
- Define virtual metrics built on derived values from the columns
- Make columns visible in the graph
- Hide visible columns
- Define additional virtual columns

You can save the modified metric template under a meaningful name

- as your own local metric template or
- in a public folder in order to share it with colleagues.

You can also combine a metric with multiple other metrics and save this bundle as a new metric template.

All metric templates which are saved as named metric templates are reusable. They are the outcome of established and approved analyses.

You might want to store all the relevant metric templates for your specific analyses you have done so far in a folder with a meaningful name.

Having such a folder with several metric templates helps you:

- To rerun the analysis you have done so far.
- To apply this expert knowledge given as metric templates to another database.
- To compare a behaviour at one point in time with another point in time.

4.3 Performing an Analysis

Look at the metric provided via Default Metric Templates:
Open (double click) the CSV file you want to analyze. The Default Metric Template which has been delivered with the Database Studio software is applied to the CSV file you have chosen.

If you already stored an own modified/enhanced Default Metric Template then this file will be opened when opening/double clicking the respective CSV file.

**Modify the Default Metric Template and store it as your personal Default Metric Template:**

Adjust the graphs according to your needs. For instructions, see the corresponding sections in *Using Database Analyzer Charts* [page 7].

**Use the predefined Metric Templates delivered with the Database Studio software:**

You can access them in the navigator view or under the path `\<workspace path>\Database Diagnosis\Local Metric Templates\SAP Metric Templates`. This is the path under which it is recommended to store the set of predefined metric templates provided by SAP.

**Technical detail:**

- Default metric templates are named like the CSV files they are associated with. User defined metric templates can have freely assigned names. They can combine more than one CSV file.
- Your personal default metric templates are stored in your actual workspace, f.e. under the path: `<HOME>\sdb\DatabaseStudio\Database Diagnosis\Default Metric Templates`.
- If you store a metric template via the context menu function "Save as Metric Template" you can choose between the local folder `<HOME>\sdb\DatabaseStudio\Database Diagnosis\Local Metric Templates\My Metric Templates` and the metrics folder you have defined in the preferences. The save dialog offers the destination folders as follows:
  - Local Metric Templates
  - My Metric Templates
  - Remote Metrics
  - You can navigate and add new folders from the save dialog

### 4.4 Retaining an Analysis

Now you have several open tables and charts that show your findings.

In the navigator view define a folder under the collection of Metric Templates. F.e. "AnalysisOfCPU-Usage"

All Metric Templates regardless whether the template applies to one single CSV file or to a combination of CSV files, just save them in the created folder of metric template.

You can save each table/chart view that you want to keep, as metric template in this folder, regardless how it has been produced (single CSV file, combination of CSV files, applied metric template, merge of applied metric template...). There is only one exception: you cannot save the merge of two date folders as a metric template.
4.5 Reproducing an Analysis

Once you have saved your own metric templates you can reuse them to reproduce an analysis. In the Explorer or Navigator view choose the Database Analyzer data that you want to examine. Mark the appropriate date folder and choose the function "Display via metric template" from the context menu. Then navigate to the folder which describes the Analysis Project.

Now you can choose the folder containing the metric templates that you want to apply on the Database Analyzer data.

As a result the data set defined in the folder of metric templates is applied to the CSV file and the appropriate data is shown in the editor part of Database Studio.

You can walk through all the tables/charts.

4.6 Applying a predefined Analysis to another database

To compare the results You found with data of a different database, just repeat the steps defined in “Reproducing an Analysis” for another date folder of another database.

4.7 Performing the same analysis for another point in time

To compare the results with another point in time regarding the same database, just apply the folder with metric templates on another date folder of the same database.

4.8 Comparing results comfortably

- Select two Database Analyzer date folders of the same database or of different databases.
- Open the context menu (with a right mouse click) and choose the metric folder which contains the Database Analyzer Project that you have executed and stored for later reuse.
- Apply this metric folder to the chosen arguments/folders.

Database Studio now opens the analysis result of every metric template in the metric template folder for the selected date folders.
You may want to see more than one chart at once. Follow these steps to split the screen for displaying multiple charts:

- In the editor part press CTRL-M. This will maximize the currently active editor section. It is also possible to click on the Maximize-icon in upper right corner of the editor.
- Drag down the tab belonging to the other database or date until you see an arrow pointing down. Then release the mouse button. This splits the editor area into two horizontal sections.
- Drag the other tabs down next to the first one. In the upper part all tables/charts of one date or database will be displayed and in the lower part the tables/charts of the other date or database.
- It is possible to switch between table and chart view. Click on the corresponding tab at the bottom of the editor to activate the chart or table view.

To restore the previous view:

- Click on the Restore-icon in upper right corner of the editor.

To apply the same time interval to one or more of the other currently opened tables:

- Place the mouse pointer over the display area containing the appropriate time interval.
- From there, open the context menu and choose the function "Select timespan in [<table-name>]".

Repeat these steps for every table which shall display the same time interval.

If you wish to better compare the values of the certain metrics, mark the two date folders and choose the context menu function "Merge via Metric Template". From the directory of metric templates choose the specific metric template that you wish to apply on both dates in one chart.
5 Working Offline with Database Analyzer Data

There are various reasons for analyzing Database Analyzer data in offline mode, e.g. access time, access authorizations or the analysis of historic data.

This chapter outlines the procedure for the analysis of offline data.

5.1 Settings for Working offline with Database Analyzer Data

For better analysis of the Database Analyzer data it might be helpful to transport the Database Analyzer from the database onto the local network. This way you can work offline on the performance data which has been collected by the Database Analyzer. You do not need to be connected to the database.

You can do this in three steps:

1. Define locations for the Database Analyzer data in the preferences settings.
2. Save selected Database Analyzer data into the locations specified by the preferences
3. Navigate to the explorer upper section "Diagnosis Local Folder" or "Diagnosis Shared Folder" where you have exported the Database Analyzer data to.
4. Define a linked folder in your navigator view. Use the upper part of the explorer view, where the folder Diagnosis Local Folder and Diagnosis Shared Folder appear after having set in the preferences.
5. Use the Navigator, where you define a linked folder to the locations of Diagnosis Local Folder and Diagnosis Shared Folder according to the settings in the preferences (link to chapter Working with the Navigator).

From the navigator view you can work locally with the remote Database Analyzer files.

5.1.1 Defining Local Locations for remote Database Analyzer Data

- Open Window → Preferences → Database Studio → Repository
- Enter a path for Diagnosis Local Folder to define a location for the function Save to Diagnosis Local...
  The default path proposed is C:/Users/<user>/sdb/My Local Folder/Diagnosis.
- Enter a path for Diagnosis Shared Folder to define a location for the function Save to Diagnosis Local...
  The default path proposed is \<servername>\any folder\DBAnalyzer\StatisticsData.

Shared folders are useful if you want to share the data with colleagues.
5.1.2 Associating the Diagnosis Editor with Database Analyzer Files

It is possible that Database Studio doesn't open the csv-file in the correct editor. In that case it is necessary to associate the correct editor.

- Choose Window → Preferences from the menu bar
- Choose General → Editors → File Associations from the expandable list on the left
- Select *.csv from the File types list or add *.csv as a new File type. The currently associated editors appear in the Associated Editors list (the list may be empty)
- In the list of "Associated editors:" choose Add... and select Diagnosis File (Table and Chart) from the list of internal editors
- Click OK and close the Preferences window

5.1.3 Importing Database Analyzer Data into the Local Locations

- In the Database Studio landscape open the Database Analyzer Folder of the respective database.
- Select one or several folders of interest (CTRL, CTRL/Shift) and right mouse click the selection to open the context menu.
- Choose either Save to Diagnosis Local... or Save to Diagnosis Shared... from the context menu to import the data.
- If you have the need to move or copy the data from the local to the shared folder or vice versa, just use the context menu functions like copy/paste.
- Importing of the Database Analyzer data can also be done via DBA Cockpit [Link].

5.2 Working Offline with the Database Analyzer Data in the Explorer View

In the Explorer view, open the directory containing the Database Analyzer data that you provided locally via Database Studio (See Importing Database Analyzer Data into the Local Locations [page 31] for details).

The local Database Analyzer data can be processed like data from a database with which you are connected. Therefore you can use all functions and features as described in the previous chapters.
5.3 Working with the Navigator

There is another way to work with data on your server or servers in your network: the Navigator view. You can open the Navigator view by Window -> Show View -> Other -> General -> Navigator.

The Navigator view will be displayed. If you do this the first time, you will only see the folder Database Diagnosis, with the subfolders Default Metric Templates and Local Metric Templates. These folders reside in the Database Studio workspace. They are automatically shown in the Navigator for your convenience.

As described in chapter Overriding the Default Metric Template of a CSV File [page 23] it is possible to come back to the Default Metric Template delivered with the software if you delete your personal default metric template which you find here in the navigator view under the subfolder Default Metric Templates.

Define further linked Folder in the Navigator View in order to access the folders you are interested in directly from Database Studio.

For details see Working offline with the Navigator [page 32].

5.3.1 Working offline with the Navigator

- In the navigator view define a link to the folder of your choice that you would like to use for external customer data:
  - Open a navigator view: Window -> Show View -> Other -> General -> Navigator
  - Right mouse click in the navigator view: New -> Project -> General -> Project -> Next -> Project Name: "External Data" -> Finish
  - Link a folder in your file system to your new folder
  - Right mouse click in the navigator view on your new folder
  - "External Data" -> New Other -> General -> Folder -> Next -> Folder name: "DBAnalyzerData" -> Advanced -> Check "Link to folder in the file system" -> Browse -> f.e.: "C:\pub\DBAnalyzer" -> Ok -> Finish
  - Or: "C:\Users\d024844\sdb\My Local Folder\DiagnosisFiles" -> Ok -> Finish -> Display the graphs in the chart view: -> Double click on an csv-file to display it in the diagnose table editor
  - Or: Right mouse click: -> Open with -> Other -> Diagnosis File (Table and Chart)

5.3.2 Defining a Linked Folder in the Navigator View

To define a linked folder:

- Right mouse click in the navigator view on the project name and select New -> Other... from the context menu.
- A dialog box opens. Here you can select a wizard for creating the linked folder. Choose General -> Folder and click the Next button to proceed.
- Enter a folder name into the text box (e.g. Shared Data).
- Click on the Advanced button and check the Link to folder in the file system option.
- Click the Browse button to specify the path for the linked folder (e.g. Y:\DBAnalyzer\CustomerStatistics)
- Click the Finish button.
  The linked folder now appears in the navigator view.
Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP intentionally or by SAP’s gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP’s current view of accessibility criteria as of the date of publication; it is in no way intended to be a binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does not apply in cases of wilful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with “you”, or a gender-neutral noun (such as “sales person” or “working days”) is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages caused by the use of related information unless damages have been caused by SAP’s gross negligence or wilful misconduct. All links are categorized for transparency (see: http://help.sap.com/disclaimer).